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incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
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consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
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specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
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The information in this document is current as of July, 2006. The information is subject to change 
without notice.  For actual design-in, refer to the latest publications of NEC Electronics data sheets or 
data books, etc., for the most up-to-date specifications of NEC Electronics products.  Not all 
products and/or types are available in every country.  Please check with an NEC Electronics sales 
representative for availability and additional information.
No part of this document may be copied or reproduced in any form or by any means without the prior       
written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that may 
appear in this document.
NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual 
property rights of third parties by or arising from the use of NEC Electronics products listed in this document 
or any other liability arising from the use of such products.  No license, express, implied or otherwise, is 
granted under any patents, copyrights or other intellectual property rights of NEC Electronics or others.
Descriptions of circuits, software and other related information in this document are provided for illustrative 
purposes in semiconductor product operation and application examples. The incorporation of these 
circuits, software and information in the design of a customer's equipment shall be done under the full 
responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.
While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics products, 
customers agree and acknowledge that the possibility of defects thereof cannot be eliminated entirely.  To 
minimize risks of damage to property or injury (including death) to persons arising from defects in NEC 
Electronics products, customers must incorporate sufficient safety measures in their design, such as 
redundancy, fire-containment and anti-failure features.
NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and 
"Specific".  
The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated "quality assurance program" for a specific application.  The recommended applications of an NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality grade of 
each NEC Electronics product before using it in a particular application. 

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc.  If customers wish to use NEC Electronics products in applications 
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to 
determine NEC Electronics' willingness to support a given application.

(Note)

•

•

•

•

•

•

M8E  02. 11-1

(1)

(2)

"NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its 
majority-owned subsidiaries.
"NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as 
defined above).

Computers, office equipment, communications equipment, test and measurement equipment, audio
and visual equipment, home electronic appliances, machine tools, personal electronic equipment
and industrial robots.
Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti-disaster
systems, anti-crime systems, safety equipment and medical equipment (not specifically designed
for life support).
Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, life
support systems and medical equipment for life support, etc.

"Standard":

"Special":

"Specific":

 



User’s Manual  U16811EJ2V0UM 5

[MEMO] 
 



User’s Manual  U16811EJ2V0UM 6 

[MEMO] 
 



User’s Manual  U16811EJ2V0UM 7

INTRODUCTION 
 

 

Readers This manual is intended for users who design and develop application systems using 

V850 microcontrollers products. 

 

Purpose This manual is intended for users to understand the functions of the Task debugger 

Ver.4.22 for RX850V4 described the organization listed below. 

 

Organization This manual consists of the following major sections. 

 

 • General 

 • Installation 

 • Starting and exiting 

 • RX850V4 functions 

 • Window reference 

 • Error messages 

 

How to read this manual It is assumed that the readers of this manual have general knowledge in the fields of 

electrical engineering, logic circuits, microcontrollers, C language, and assemblers. 

 

 To understand the hardware functions of the V850 microcontrollers  

 → Refer to the User’s Manual  Hardware of each product. 

 

 To understand the instruction functions of the V850 microcontrollers  

 → Refer to the V850ES Architecture User’s Manual (U15943E) or  

      V850E1 Architecture User’s Manual (U14559E).  

 

Conventions Data significance: Higher digits on the left and lower digits on the right  

 Note: Footnote for item marked with Note in the text  

 Caution: Information requiring particular attention  

 Remark: Supplementary information  

 Numerical representation: Binary...XXXX or XXXXB 

  Decimal...XXXX 

  Hexadecimal...0xXXXX 

 Prefixes indicating power of 2 (address space and memory capacity):  

  K (kilo) 210 = 1024 

  M (mega) 220 = 10242 
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Related Documents Read this manual together with the following documents. 

 The related documents indicated in this publication may include preliminary versions. 

However, preliminary versions are not marked as such. 

 

Documents related to development tools (user’s manuals) 

Document Name Document Number 

Operation U17293E 

C Language U17291E 

Assembly Language U17292E 

CA850 Ver. 3.00 C Compiler Package 

Link Directives U17294E 

ID850 Ver. 3.00 Integrated Debugger Operation U17358E 

ID850NW Ver. 3.00, 3.10 Integrated Debugger Operation U17369E 

ID850NWC Ver. 2.51 Integrated Debugger Operation U16525E 

ID850QB Ver. 3.20 Integrated Debugger Operation U17964E 

Operation U18010E SM+ System Simulator 

User Open Interface U18212E 

SM850 Ver. 2.50 System Simulator Operation U16218E 

SM850 Ver. 2.00 or later System Simulator External Part User Open Interface Specifications U14873E 

Functionalities U16643E 

Internal Structure U16644E 

RX850V4 Ver. 4.22 Real-Time OS 

Task Debugger This manual 

AZ850V4 Ver. 4.10 System Performance Analyzer U17093E 

PG-FP4 Flash Memory Programmer U15260E 

TW850 Ver. 2.00 Performance Analysis Tuning Tool U17421E 

PM+ Ver. 6.20 Project Manager U17990E 
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CHAPTER 1  GENERAL

1. 1  Overview
The RD850V4 (the task debugger for the RX850V4 is referred to as the RD850V4 in this user's manual) expands 

debugger functions by connecting with a debugger using an RTOS debugging interface module (RIM).
The RD850V4 provides the following functions.

-  The real-time OS resource display function
Acquires the statuses of OS resources (such as tasks and semaphores) managed by the RX850V4 automatically 
and displays their information when a break occurs at a certain point of a load module running in the debugger.

-  The real-time OS status change function
Changes the OS resource statuses (current values).
This function is available only when the RD850V4 is used together with a debugger such as the ID850 (including 
ID850NW, ID850QB, SM850, SM+ for V850).

The RD850V4 acquires various kinds of information via communication with the debugger and RIM. When using the 
RD850V4, the debugger must therefore run at the same time.

When acquiring the OS resource statuses or changing the statuses, the following conditions must be satisfied.

 

1. 2  System Configuration
The RD850V4 connects with the debugger using RIM and extends the debugger functions.
The system configuration of the RD850V4 is as follows:

Figure 1-1  System Configuration

-  A load module linked with the RX850V4 has been downloaded to the debugger.

-  RX850V4 system initialization processing has been completed.

RD850V4Debugger

Host machine

Target system
 (In-circuit emulator,ROM emulator, 
ROM monitor, etc.)

RX850V4

R I M
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1. 3  Operating Environment
To use the RD850V4, an environment in which a debugger operates is required.

Since the RD850V4 is an application for .NET Framework, Microsoft® .NET Framework must be installed 
separately, from the dotnet1.1 folder in the supplied CD-ROM.

For the latest information on the .NET Framework, refer to http://www.microsoft.com/japan/msdn/netframework/.

-  Host machine
The machine by which the target OS operates.

Windows® 2000, Windows XP Home Edition, Windows XP Professional

[Caution]  It is recommended that the newest Service Pack be installed in any of the above OSs.

-  Software

-  Debugger
Debugger supporting TIP

ID850, ID850NW, ID850QB, SM850, SM+ for V850 (from NEC Electronics)

Multi® 2000 (from Green Hills® Software, Inc.)

-  Execution environment
Microsoft .NET Framework V1.1 SP1 or later

-  Real-time OS
RX850V4 V4.20 or later (from NEC Electronics)
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CHAPTER 2  INSTALLATION

2. 1  Installing RD850V4
The RD850V4 is included with the real-time OS package (RX850V4). When the RX850V4 is installed, the RD850V4 

can be also installed if necessary, as it is supplied in the same package.
For the details on how to install the RX850V4, refer to the RX850V4 user's manual.

2. 2  Folder Configuration
After installing the RD850V4, the configuration of the folders related to the RD850V4 is as follows:

Figure 2-1  Folder Configuration

A shortcut for the RD850V4 (default: [Program] ->[NEC Electronics Tools] -> [RD850V4] -> [Vx.xx] -> [RD850V4 
Vx.xx]) is automatically added to the Windows start menu.

2. 3  Uninstalling RD850V4
Uninstall the RD850V4 with the following procedure.

(1) Start up Windows.

(2) Select "Add/Remove Programs" ("Add or Remove Programs" in the case of Windows XP) from the control 
panel.

(3) Select items to be uninstalled.

-   RD850V4 V850 Task Debugger Vx.xx

-   RD850V4 (Vx.xx) documents

(4) Perform uninstallation according to the message displayed.

Installation folder (default: C:\Program Files\NEC Electronics Tools\RD850V4\Vx.xx)

bin

hlp Help file (*.chm)

doc Document-related files (*.pdf, *.txt)

Execution files, DLL files, etc.
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CHAPTER 3  STARTING AND EXITING

3. 1  Starting
Select Windows Start menu -> [Programs] -> [NEC Electronics Tools] -> [RD850V4] -> [Vx.xx] -> [RD850V4 Vx.xx] 

(default); the RD850V4 then starts.
When the RD850V4 is started, the Main window shown below will be displayed and a tray icon will be displayed in 

the Windows notification area (task tray) (refer to "5. 2  Tray Icon").

Figure 3-1  RD850V4 Startup Screen

Figure 3-2  Tray Icon of RD850V4

[Caution 1]  The RD850V4 acquires various kinds of information via communication with the debugger and RIM. 
When using the RD850V4, the debugger must therefore run at the same time.

[Caution 2]  Multiple RD850V4 programs cannot run at a time. If the RD850V4 has already been started, the 
RD850V4 window is displayed in the front.

[Caution 3]  When debugging programs by using PM+, the RD850V4 can be started using the PM+ menu bar or 
icon.

3. 2  Exiting
To exit the RD850V4, select [File] menu -> [Exit] item on the Main window.
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CHAPTER 4  RD850V4 FUNCTIONS

4. 1  The Real-time OS Resource Display Function
This is the function that acquires the statuses of OS resources (such as tasks and semaphores) managed by the 

RX850V4 automatically and displays their information.
Radix notation of the displayed values can be switched between decimal and hexadecimal, in the [Options] dialog 

box.
The status of each object is displayed in the following windows.

-  Main window
This widnow is the first window to be opened after RD850V4 is started.
To use RD850V4, start operational from this window.

-  Properties window
This window is opened by double-clicking an arbitrary object displayed in the List view area in the Main window, 
and displays detailed information on the selected object.
Among the items displayed, the current value of specific items can be changed in this window.
The following property windows are available for each target object. (The "property window" is the generic name of 
these windows.)

- [Task(s)] window
- [Semaphore(s)] window
- [Eventflag(s)] window
- [Data queue(s)] window
- [Mailbox(s)] window
- [Mutex(s)] window
- [Timer queue] window
- [Ready queue(s)] window
- [Fixed-sized memory pool(s)] window
- [Variable-sized memory pool(s)] window
- [Cyclic handler(s)] window
- [CPU exception handler(s)] window
- [Interrupt handler(s)] window
- [Extended service call routine(s)] window
- [Idle routine] window
- [System] window
- [Max value] window
- [Memory area(s)] window
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4. 2  The Real-time OS Status Change Function
This is the function that changes the OS resource statuses (current values).
This function is available only when the RD850V4 is used together with a debugger such as the ID850 (including 

ID850NW, ID850QB, SM850, SM+ for V850).
The following property windows have this status change function.

 - [Task(s)] window
 - [Semaphore(s)] window
 - [Eventflag(s)] window
 - [Mutex(s)] window
 - [Ready queue(s)] window
 - [Cyclic handler(s)] window
 - [System] window

4. 2. 1  Conditions required for changing status

The following conditions must be satisfied when changing the OS resource statuses (current values) in a property 
window shown in "4. 2  The Real-time OS Status Change Function".

(1) System status type

Basically, the object status change function is not available when the current system status is the CPU locked 
state. If the current system status is the CPU locked state, only the "CPU locked state" item in the [System] 
window can be changed.
When using this function, check that "False" is displayed as the value of "CPU locked state" in the [System] 
window.

(2) Service calls required for changing object status

The object status change function is achieved by issuing RX850V4 service calls from the RD850V4. When using 
this function, service calls to be used must therefore be linked with the load module in advance.
The following lists the service calls required for using this function in each property window.

Table 4-1  Service Calls Required for Changing Object Status

-  The current system status is the CPU unlocked state.

-  Service calls required for changing the object status are linked with the load module.

-  The debugger used in combination with the RD850V4 is any of ID850, ID850NW, ID850QB, SM850, 
and SM+ for V850.

Property Windo Name Service Call Name

[Task(s)] window chg_pri, sus_tsk, rsm_tsk, wup_tsk, can_wup, act_tsk, can_act, rel_wai, ter_tsk

[Semaphore(s)] window sig_sem, pol_sem

[Eventflag(s)] window set_flg, clr_flg

[Mutex(s)] window unl_mtx

[Ready queue(s)] window rot_rdq

[Cyclic handler(s)] window sta_cyc, stp_cyc

[System] window ena_dsp, dis_dsp, loc_cpu, unl_cpu
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(3) Debugger is used with RD850V4

The object status change function is available only when the RD850V4 is used together with a debugger such as 
the ID850 (including ID850NW, ID850QB, SM850, SM+ for V850).

4. 2. 2  Caution

(1) Reflecting the changed status

Change to the current values is not reflected just by inputting values to the relevant text box. To update the 

current value, it is necessary to click the  button or select the [View] menu -> [Refresh].

(2) Rules for inputting to text boxes

The rules for inputting to status change text boxes are as follows.

Table 4-2  Rules for Inputting to Text Boxes

Radix Notation Input Rule

Hexadecimal Must start with "0x" and include one or more alphanumeric characters from 0 
to 9 or a to f.
The alphabetic characters are not case-sensitive.

Decimal Include one or more numeric values from 0 to 9.
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4. 3  Mode Setting for Each Window and Interrelationships
The following two modes are available in each RD850V4 window. Change to the appropriate mode in the process of 

debugging.
The default mode when the RD850V4 is started can be changed in the [Options] dialog box.

-  Status update mode
When a break occurs in the connected debugger, the RD850V4 automatically sends a notice to all of the 
windows currently open, to prompt updating of information. The status update mode is used to set whether to 
update the displayed contents automatically. This mode can be set individually to the Main window and all of the 
property windows currently open.
The status update mode has the following two types.

Table 4-3  Status Update Modes

-  Window discard mode
The window discard mode is used to set whether to close a property window automatically when an object 
subject to be displayed in the property window is deleted. This mode can be set individually to all of the property 
windows currently open.
The window discard mode has the following two types.

Table 4-4  Window Discard Mode

[Caution]  Since the RX850V4 does not have an object delete function, property windows are not closed even if 
the automatic discard mode is set. 

Mode Function and Setting Method

Automatic update Updates the displayed contents automatically when a break occurs in the 
debugger (default).
This mode is set by turning off [Update Manually] in the [View] menu.

Manual update Does not update the displayed contents when a break occurs in the debugger.
This mode is set by turning on [Update Manually] in the [View] menu.
To update the displayed contents, execute [Refresh] in the [View] menu.

Mode Function and Setting Method

Automatic discard Closes the window automatically when the corresponding object is deleted 
(default).
This mode is set by turning off [Close Manually] in the [Window] menu.

Manual discard Does not close the window even if the corresponding object is deleted.
This mode is set by turning on [Close Manually] in the [Window] menu.
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The window interrelationships that are changed by mode setting are as follows.

Figure 4-1  Window Behavior Caused by Mode Setting

Automatic updateUpdate notice

Manual update

[Automatic discard]
Closes the window automatically 
when the corresponding object is 
deleted.

[Automatic update]
Updates the displayed contents 
automatically when a break 
occurs in the debugger.

[Manual update]
Does not update the displayed 
contents when a break occurs in 
the debugger.

Automatic updateManual updateAutomatic update

Automatic discard
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CHAPTER 5  WINDOW REFERENCE

5. 1  Outline of Windows and Dialog Boxes of RD850V4
The following shows the list of windows and dialog boxes of the RD850V4.

Table 5-1  List of Windows and Dialog Boxes of RD850V4

Window/Dialog Box Name Function

Main window This widnow is the first window to be opened after RD850V4 is started.
To use RD850V4, start operational from this window.

Properties window This window is opened by double-clicking an arbitrary object displayed 
in the List view area of the Main window, and displays detailed 
information on the selected object.
Among the items displayed, the current value of specific items can be 
changed in this window.
The following property windows are available for each target object. 
(The "property window" is the generic name of these windows.)

-  [Task(s)] window

-  [Semaphore(s)] window

-  [Eventflag(s)] window

-  [Data queue(s)] window

-  [Mailbox(s)] window

-  [Mutex(s)] window

-  [Timer queue] window

-  [Ready queue(s)] window

-  [Fixed-sized memory pool(s)] window

-  [Variable-sized memory pool(s)] window

-  [Cyclic handler(s)] window

-  [CPU exception handler(s)] window

-  [Interrupt handler(s)] window

-  [Extended service call routine(s)] window

-  [Idle routine] window

-  [System] window

-  [Max value] window

-  [Memory area(s)] window

[Options] dialog box Sets the basic RD850V4 operation and display formats.

[About RD850V4] dialog box Displays the information about the RD850V4.
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5. 2  Tray Icon
The RD850V4 displays the following tray icon in the Windows status area (taskbar).

Figure 5-1  Tray Icon of RD850V4

The tray icon supports manipulation for the RD850V4 Main window and property windows. It displays the following 
context menus by right-clicking the tray icon.

Figure 5-2  Context Menu of Tray Icon

Table 5-2  Items Displayed in Context Menu: Tray Icon

Property window name

Item Function

Property window 
name

Brings the selected property window to the front.
All of the property windows currently open are displayed in this field.

Cascade Specifies whether to display all the property windows overlapped.
By turning on this menu, all the property windows are displayed being overlapped by 
gradually shifting their X and Y coordinates at constant intervals, based on the coordinates 
of the Main window.

Tile Vertically Specifies whether to arrange all the property windows vertically.
By turning on this menu, all the property windows are displayed being arranged vertically 
in the entire screen display area.

Tile Horizontally Specifies whether to arrange all the property windows horizontally.
By turning on this menu, all the property windows are displayed being arranged 
horizontally in the entire screen display area.

Close All Closes all of the property windows.

Exit Terminates the RD850V4.

Cancel Cancels the manipulation.
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5. 3  Explanation of Windows and Dialog Boxes
This section describes each window/dialog box of the RD850V4 as follows:

Window/Dialog box name

Show in the frame are the window or dialog box name.
In addition, the display image of the window or dialog box, functional outline, and how open the window or dialog box 

are also explained.

Explanation of each area

Explains items to be set to or displayed in each area of the window or dialog box.

Menu bar

List the menu items and explains the operation of each menu item.

Tool bar

Explains the operation of each button on the tool bar.

Function buttons

Explains the operation of each function button in the window or dialog box.

Caution

Enumerates points that require care during operation in the window or dialog box.

Other

Explains the special functions of the window or dialog box, such as the operating method.
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Main window

This widnow is the first window to be opened after RD850V4 is started.
To use RD850V4, start operational from this window.

Figure 5-3  Main Window: Select [View] Menu -> [Details] Item

This section describes the following items:

-  Explanation of each area

-  Menu bar

-  Tool bar

-  Status bar

Tool bar

Menu bar

Status bar

Tree view area List view area
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Explanation of each area

(a)  Tree view area

OS resources included in a load module are expanded into tree form.
The plus/minus sign on the left side of icons indicate that the resources which belong to the selected element 
are in an expanded/collapsed structure. The resources are expanded by clicking the plus sign, and collapsed by 
clicking the minus sign. (Whether to display the plus/minus sign can be specified in the [TREE] group in the 

[Options] dialog box).
By clicking one of the resources, a list of objects created in the selected resource is displayed in the List view 
area.
The resource structure in the Tree view area is as follows.

Figure 5-4  Tree View Area

RX850V4
TASK

Task[s]

SYNCHRONIZATION / COMMUNICATION

Mutex[s]

Mailbox[s]

Data queue[s]

Eventflag[s]

Semaphore[s]

SYSTEM QUEUE

Ready queue

Timer queue

MEMORY POOL

Variable-sized memory pool[s]

Fixed-sized memory pool[s]

HANDLER / ROUTINE

Idle routine

Extended service cakk routine[s]

Interrupt handler[s]

CPU exception handler[s]

Cyclic handler[s]

OTHER

Max value

System

Memory area[s]
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(b)  List view area

Displays a list of objects created in the resource selected in the Tree view area.
The focused resource can also be changed by selecting a tab in this area. (The tab operates in conjunction with 
the Tree view area.)
When an arbitrary object displayed in the list is double-clicked, a Properties window (refer to "4. 1  The Real-time 
OS Resource Display Function"), which displays the detailed information on the selected object, will be opened.
Multiple Properties window screens can be opened at the same time.

The display format in this area can be switched by selecting items in the [View] menu, as shown below.
The arrow shown in each figure indicates the object arrangement order.

Figure 5-5  Select [View] Menu -> [Large Icons] Item

Figure 5-6  Select [View] Menu -> [Small Icons] Item

Figure 5-7  Select [View] Menu -> [List] Item
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If [Details] is selected in the [View] menu, the listed items can be sorted by clicking the column header of the 
desired item.
At this time, the sort method is toggled as "descending order -> ascending order -> not sorted".

[Caution 1]  If the object names to be displayed in the list view area cannot be acquired, the RD850V4 
alternately uses symbol names if symbol information is included in the load module, or IDs if symbol 
information is not included in the load module.

[Caution 2]  By sliding the boundary between the tree view area and list view area, their display area sizes can 
be changed.
If the window is resized, however, horizontal increase or decrease is only reflected to the list view 
area.

Icons that indicate object names vary depending on the type of the resource selected in the tree view area and 
its status, as shown below.

Table 5-3  Icon Types Used for Task Information

Table 5-4  Icon Types Used for Semaphore Information

Large Icons Small Icons Task Status

DORMANT state

READY state

RUNNING state

WAITING state

SUSPENDED state

WAITING-SUSPENDED state

State out of RX850V4 control

Large Icons Small Icons Semaphore Wait Queue Status

There are no tasks waiting (Empty)

There is a task waiting (Waiting Tasks)
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Table 5-5  Icon Types Used for Eventflag Information

Table 5-6  Icon Types Used for Data Queue Information

Table 5-7  Icon Types Used for Mailbox Information

Table 5-8  Icon Types Used for Mutex Information

Large Icons Small Icons Eventflag Wait Queue Status

There are no tasks waiting (Empty)

There is a task waiting (Waiting Tasks)

Large Icons Small Icons Data  Queue Wait Queue Status

There are no tasks waiting (Empty)

There is a task waiting for transmission (Waiting 
Transmissions)

There is a task waiting for reception (Waiting Receptions)

Large Icons Small Icons Mailbox Wait Queue Status

There are no tasks waiting and there are no messages 
(Empty)

There is a task waiting for reception (Waiting Tasks)

There is a message waiting for reception (Waiting 
Messages)

Large Icons Small Icons Mutex Wait Queue Status

There are no tasks waiting (Empty)

There is a task waiting (Waiting Tasks)
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Table 5-9  Icon Types Used for Timer Queue Information

Table 5-10  Icon Types Used for Ready Queue Information

Table 5-11  Icon Types Used for Ready Queue Information

Table 5-12  Icon Types Used for Variable-Sized Memory Pool Queue Information

Table 5-13  Icon Types Used for Cyclic Handler Information

Large Icons Small Icons Status

-

Large Icons Small Icons Status

-

Large Icons Small Icons Fixed-Sized Memory Pool Wait Queue Status

There are no tasks waiting (Empty)

There is a task waiting (Waiting Tasks)

Large Icons Small Icons Variable-Sized Memory Pool Wait Queue Status

There are no tasks waiting (Empty)

There is a task waiting (Waiting Tasks)

Large Icons Small Icons Cyclic Handler Status

Operational state

Non-operational state
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Table 5-14  Icon Types Used for CPU Exception Handler Information

Table 5-15  Icon Types Used for Interrupt Handler Information

Table 5-16  Icon Types Used for Extended Service Call Information

Table 5-17  Icon Types Used for Idle Routine Information

Table 5-18  Icon Types Used for System Information

Table 5-19  Icon Types Used for Maximum Value Information

Large Icons Small Icons Status

-

Large Icons Small Icons Status

-

Large Icons Small Icons Status

-

Large Icons Small Icons Status

-

Large Icons Small Icons Status

-

Large Icons Small Icons Status

-
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Table 5-20  Icon Types Used for Memory Area Information

Menu bar

(a)  [File] menu

(b)  [View] menu

Large Icons Small Icons Status

-

Open... This version of the RD850V4 does not support this function.

Save This version of the RD850V4 does not support this function.

Save As... This version of the RD850V4 does not support this function.

Exit Terminates the RD850V4.

Toolbar Switches displaying and hiding the toolbar.
The toolbar is displayed by turning on this item.

Status Bar Switches displaying and hiding the status bar.
The status bar is displayed by turning on this item.

Large Icons Specifies the list view area display format.
Objects are displayed with large icons by selecting this item.

Small Icons Specifies the list view area display format.
Objects are displayed with small icons by selecting this item.

List Specifies the list view area display format.
Objects are displayed in the list format by selecting this item.
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(c)  [Tool] menu

(d)  [Window] menu

Details Specifies the list view area display format.
Detailed information is displayed for the object list by selecting this item.

Previous Resource Select the previous resource.

Same operation as  button on the toolbar.

Next Resource Select the next resource.

Same operation as  button on the toolbar.

Update Manually Switches the status update mode (automatic update or manual update) in the 
window.
By turning on this menu, manual update (the displayed contents are not updated 
when a break occur is the debugger) is set.

It can also be switched by clicking the icon on the Status bar (  /  ).

Refresh Updates the list view area.

Same operation as  button on the toolbar.

Connect Connects the RD850V4 and the debugger.

Disconnect Disconnects the RD850V4 and the debugger.

Options... Opens the [Options] dialog box.

Always on Top Specifies whether to fix the window display in the front.
The window is always displayed in the front by turning on this item.

Same operation as  button on the toolbar.

Cascade Specifies whether to display all the property windows overlapped.
By checking this item, all the property windows are displayed being overlapped by 
gradually shifting their X and Y coordinates at constant intervals, based on the 
coordinates of the Main window.
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(e)  [Help] menu

Tool bar

This is a button group that enables execution of frequently used commands via a single click.

Table 5-21  Tool Bar of Main Window

Tile Vertically Specifies whether to arrange all the property windows vertically.
By checking this item, all the property windows are displayed being arranged 
vertically in the entire screen display area.

Tile Horizontally Specifies whether to arrange all the property windows horizontally.
By checking this item, all the property windows are displayed being arranged 
horizontally in the entire screen display area.

Property window 
name

Brings the selected property window to the front.
All of the property windows currently open are displayed in this field.

Help Contents Opens the RD850V4 online help.

Help Topics Searches for topics in the RD850V4 online help.

NEC Electronics 
Microcomputer (web 
site)

Opens the Web site for NEC Electronics microcontrollers.
The Web site can be opened only when the host machine is connected to the 
Internet.

V850 FAQ (web site) Opens the Web site for V850 microcontroller tool FAQ.
The Web site can be opened only when the host machine is connected to the 
Internet.

About RD850V4... Opens the [About RD850V4] dialog box.

Button Function

This version of the RD850V4 does not support this function.

This version of the RD850V4 does not support this function.

Select the previous resource.
Same operation as [View] menu -> [Previous Resource] item.

Select the next resource.
Same operation as [View] menu -> [Next Resource] item.

Refresh the contents of the current list.
Same operation as [View] menu -> [Refresh] item.

Keep this window always on top.
Same operation as [Window] menu -> [Always on Top] item.
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Status bar

The following shows the status bar in this window.

Figure 5-8  Status Bar of Main Window

The functions of each item are as follows.

Table 5-22  Items Displayed on Status Bar: Main Window

Message Radix notation

Status update mode

Connection status

Progress bar

Item Icon Function

Message - Displays the message on the window status.
A message dialog box will also be displayed in the case of the 
Question Message, Warning Message, and Operation Error.

Progress bar Displays the percentage of the displayed contents update process 
that has been completed.

Radix notation decimal
hexadecimal

Displays the radix notation for numeric values.
The radix notation can be switched between hexadecimal and 
decimal by clicking the label.

Status update mode (automati-
cally)

Displays the current status update mode in the window.
The status update mode can be switched between the automatic 
update and manual update by clicking each icon.(manually)

Connection status online Indicates the status of connection with the debugger.

offline
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Properties window

This window is opened by double-clicking an arbitrary object displayed in the List view area of the Main window, and 
displays detailed information on the selected object.

Among the items displayed, the current value of specific items can be changed in this window.

Figure 5-9  Properties Window

This section describes the following items:

-  Menu bar

-  Tool bar

-  Status bar

-  Caution

-  Displayed contents of each object and current value change method

-  [Task(s)] window

-  [Semaphore(s)] window

-  [Eventflag(s)] window

-  [Data queue(s)] window

-  [Mailbox(s)] window

-  [Mutex(s)] window

-  [Timer queue] window

-  [Ready queue(s)] window

-  [Fixed-sized memory pool(s)] window

-  [Variable-sized memory pool(s)] window

-  [Cyclic handler(s)] window

-  [CPU exception handler(s)] window

Status bar

Menu bar

Tool bar
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-  [Interrupt handler(s)] window

-  [Extended service call routine(s)] window

-  [Idle routine] window

-  [System] window

-  [Max value] window

-  [Memory area(s)] window

Menu bar

(a)  [File] menu

(b)  [View] menu

Close Closes this window.

Undo Restores the status before change.

The status before clicking the  button or selecting [Refresh] in the 

[View] menu cannot be restored.
This item is not available in property windows that do not have the status change 
function (such as [Data queue(s)] window and [Mailbox(s)] window).

Same operation as  button on the toolbar.

Toolbar Switches displaying and hiding the toolbar.
The toolbar is displayed by checking this item.

Status Bar Switches displaying and hiding the status bar.
The status bar is displayed by checking this item.

Update Manually Switches the status update mode (automatic update or manual update) in the 
window.
By turning on this menu, manual update (the displayed contents are not updated 
when a break occur is the debugger) is set.

It can also be switched by clicking the icon on the Status bar (  /  ).

Refresh Updates the displayed contents in the window.

Same operation as  button on the toolbar.
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(c)  [Window] menu

(d)  [Help] menu

Always on Top Specifies whether to fix the window display in the front.
The window is always displayed in the front by turning on this item.

Same operation as  button on the toolbar.

Cascade Specifies whether to display all the property windows overlapped.
By turning on this menu, all the property windows are displayed being overlapped 
by gradually shifting their X and Y coordinates at constant intervals, based on the 
coordinates of the Main window.

Tile Vertically Specifies whether to arrange all the property windows vertically.
By turning on this menu, all the property windows are displayed being arranged 
vertically in the entire screen display area.

Tile Horizontally Specifies whether to arrange all the property windows horizontally.
By turning on this menu, all the property windows are displayed being arranged 
horizontally in the entire screen display area.

Close Manually Switches the window discard mode (automatic discard or manual discard).
By turning on this menu, manual discard (the window is not closed even if the 
corresponding object is deleted) is set.

It can also be switched by clicking the icon on the Status bar (  /  ).

Help Contents Opens the RD850V4 online help.

Help Topics Searches for topics in the RD850V4 online help.

About RD850V4... Opens the [About RD850V4] dialog box.
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Tool bar

This is a button group that enables execution of frequently used commands via a single click.

Table 5-23  Tool Bar of Properties Window

Status bar

The following shows the status bar in this window.

Figure 5-10  Status Bar of Properties Window

The functions of each item are as follows.

Table 5-24  Items Displayed on Status Bar: Properties Window

Button Function

Restores the status before change.

The status before clicking the  button or selecting [Refresh] in the [View] 

menu cannot be restored.
This item is not available in property windows that do not have the status change 
function (such as [Data queue(s)] window and [Mailbox(s)] window).
Same operation as [View] menu -> [Undo] item.

Updates the displayed contents in the window.
Same operation as [View] menu -> [Refresh] item.

Always displays the window in the front.
Same operation as [Window] menu -> [Always on Top] item.

Message

Radix notation

Status update mode

Window discard mode

Item Icon Function

Message - Displays the message on the window status.
A mes
sage dialog box will also be displayed in the case of the Question 
Message, Warning Message, and Operation Error, message 
dialog box.

Radix notation decimal
hexadecimal

Displays the radix notation for numeric values.
The radix notation can be switched between hexadecimal and 
decimal by clicking the label.

Status update mode (automatic
ally)

Displays the current status update mode in the window.
The status update mode can be switched between the automatic 
update and manual update by clicking each icon.(manually)
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Caution

-  Basically, the object status change function is not available when the current system status is the CPU locked 
state. If the current system status is the CPU locked state, only the "CPU locked state" item in the [System] 
window can be changed.

-  Change to the current values is not reflected just by inputting values to the relevant text box. To update the 

current value, it is necessary to click the  button or select the [View] menu -> [Refresh].

Window discard mode (automatic
ally)

Displays the current window discard mode in the window.
The window discard mode can be switched between the automatic 
discard and manual discard by clicking each icon.(manually)

Item Icon Function
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[Task(s)] window

This window is opened by double-clicking an arbitrary task displayed in the [Task(s)] tab in the Main window, and 
displays detailed information on the selected task.

Among the items displayed, the current values of Status, Priority, Suspend count, Wakeup count, and Activate count 
can be changed in this window.

Figure 5-11  [Task(s)] Window

This section describes the following items:

-  Explanation of each area

-  Current value change method

-  Displaying of task source

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target task.
The current values of items marked with a circle in the Change column can be changed. See "Current value 
change method" for details on how to change the current value.
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Table 5-25  Items Displayed on [Properties] Tab: [Task(s)] Window

Change Item Contents

Name Displays the name of the task.
This item is displayed only when the name is specified as an ID in the 
system configuration file.

ID Displays the ID of the task.

O Status Displays the current state of the task.
This item is displayed in the following format.
  state @ waiting resource (ID) & additional information

There are following types of task statuses.

Dormant DORMANT state

Ready READY state

Running RUNNING state

Waiting WAITING state

Suspended SUSPENDED state

Waiting-Suspended WAITING-SUSPENDED state

Non-Existent State out of RX850V4 control

If a task is in the WAITING state or WAITING-SUSPENDED state, the 
waiting resource type and the target object ID will be displayed 
additionally.
There are following types of waiting resources.

SEM Waiting state for a semaphore

FLG Waiting state for an eventflag

SDTQ Sending waiting state for a data queue

RDTQ Receiving waiting state for a data queue

MBX Waiting state for a mailbox

MTX Waiting state for a mutex

MPF Waiting state for a fixed-sized memory pool

MPL Waiting state for a variable-sized memory 
pool

SLP Sleeping state

DLY Delayed state

The following additional information may also be displayed, depending 
on the task status.

TMO Waiting with timeout

PRI Wait queue is in priority order.

TEX Task exception handling being performed

O Priority Displays the current priority of the task.

Initial priority Displays the initial priority of the task.
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Entry Displays the start address of the task.
The display format varies as follows, depending on the load module 
generation condition.

-  With debug information:
File name # Line number (Symbol name)

-  With symbol information:
Address (Symbol name)

-  Without symbol information:
Address

Stack size Displays the task stack size (in bytes).
This item is displayed in the following format.
  Bottom address - Top address (size)

Stack rate Displays the percentage of the consumed task stack amount with the 
progress bar.

SP Displays the stack pointer.

PC Displays the current PC.
The display format of this item is the same as that of [Entry].

Interruption Displays the task interrupt status (enable/disable of maskable interrupt 
acknowledgment).
There are following types of task interrupt statuses.

TA_ENAINT Acknowledgment of maskable interrupt is 
enabled.

TA_DISINT Acknowledgment of maskable interrupt is 
disabled.

O Suspend count Displays the suspension count of the task.

O Wakeup count Displays the wakeup request count of the task.

O Activate count Displays the activation request count of the task.

Change Item Contents
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Attribute Displays the attribute of the task.
There are following types of task attributes.

[Coding language]

TA_HLNG Start a processing unit through a C language 
interface.

TA_ASM Start a processing unit through an assembly 
language interface.

[Initial activation status]

TA_ACT Task is activated after the creation.

[Task type]

TA_RSTR Restricted task

[Preempt acknowledge status]

TA_DISPREEMPT Acknowledgment of preempt is disabled 
when the task moves from the DORMANT to 
the READY state.

[Initial interrupt status]

TA_ENAINT Acknowledgment of maskable interrupt is 
enabled.

TA_DISINT Acknowledgment of maskable interrupt is 
disabled.

Extra information Displays the extended information of the task.

TEX attribute Displays the attribute of the task exception handling routine.
This item is displayed only when task exception handling routines are 
registered to the task.
There are following types of task exception handling routine attributes.

[Coding language]

TA_HLNG Start a processing unit through a C language 
interface.

TA_ASM Start a processing unit through an assembly 
language interface.

[Current state]

TTEX_ENA Task exception enabled state

TTEX_DIS Task exception disabled state

TEX entry Displays the task exception handling routine start address.
This item is displayed only when task exception handling routines are 
registered to the task.
The display format of this item is the same as that of [Entry].

TEX pattern Displays the pending exception code.
This item is displayed only when task exception handling routines are 
registered to the task.

Change Item Contents
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(b)  [n locking mutex(s)] tab

The items listed in the following table will be displayed as the mutex information of the target task.
"n" is the variable that indicates the total number of mutexes locked by the target task.

Figure 5-12  [n locking mutex(s)] Tab: [Task(s)] Window

Table 5-26  Items Displayed on [n locking mutex(s)] Tab: [Task(s)] Window

Current value change method

The current value can be changed by inputting/selecting numeric values to the text box/drop-down list that is opened 
when the relevant item in this window is double clicked.

After changing the current value, the change will be reflected to the target system by clicking the  

button or by selecting [Refresh] in the [View] menu.

Displaying of task source

The source of the relevant task can be displayed in the debugger's Source window by double-clicking the [Entry] 
item. The source corresponding to the relevant PC value can also be displayed by double-clicking the [PC] item.

If no debug information is included in the target load module, the Assemble window, instead of the Source window, 
will be opened.

[Caution]  If a debugger other than one made by NEC Electronics is used, this function (displaying of task 
source) may not operate normally.

Item Contents

Locking mutex Displays the mutex name.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

Mutex ID Displays the mutex ID.
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[Semaphore(s)] window

This window is opened by double-clicking an arbitrary semaphore displayed in the [Semaphore(s)] tab in the Main 
window, and displays detailed information on the selected semaphore.

Among the items displayed, the current value of Count can be changed in this window.

Figure 5-13  [Semaphore(s)] Window

This section describes the following items:

-  Explanation of each area

-  Current value change method

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target semaphore.
The current values of items marked with a circle in the Change column can be changed. See "Current value 
change method" for details on how to change the current value.

Table 5-27  Items Displayed on [Properties] Tab: [Semaphore(s)] Window

Change Item Contents

Name Displays the name of the semaphore.
This item is displayed only when the name is specified as an ID in the 
system configuration file.

ID Displays the ID of the semahpore.

Queue status Displays the wait queue status.
The following types of wait queue statuses are available.

Empty No tasks waiting

Waiting Tasks A task is waiting

O Count Displays the current resource count of the semaphore.

Max count Displays the maximum resource count of the semaphore.
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(b)  [n waiting task(s)] tab

The items listed in the following table will be displayed as information on tasks waiting for the target semaphore.
"n" is the variable that indicates the total number of tasks queued to the target semaphore wait queue.

Figure 5-14  [n waiting task(s)] Tab: [Semaphore(s)] Window

Table 5-28  Items Displayed on [n waiting task(s)] Tab: [Semaphore(s)] Window

Current value change method

The current value can be changed by inputting/selecting numeric values to the text box/drop-down list that is opened 
when the relevant item in this window is double clicked.

After changing the current value, the change will be reflected to the target system by clicking the  

button or by selecting [Refresh] in the [View] menu.

Initial count Displays the initial resource count of the semaphore.

Attribute Displays the attribute of the semaphore.
There are following types of semaphore attributes (task queuing 
methods).

TA_TFIFO Task wait queue is in FIFO order.

TA_TPRI Task wait queue is in task priority order.

Change Item Contents

Item Contents

Waiting task Displays the name of the waiting task.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

Task ID Displays the ID of the waiting task.

Priority Displays the priority of the waiting task.
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[Eventflag(s)] window

This window is opened by double-clicking an arbitrary eventflag displayed in the [Eventflag(s)] tab in the Main 
window, and displays detailed information on the selected eventflag.

Among the items displayed, the current value of Pattern can be changed in this window.

Figure 5-15  [Eventflag(s)] Window

This section describes the following items:

-  Explanation of each area

-  Current value change method

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target eventflag.
The current values of items marked with a circle in the Change column can be changed. See "Current value 
change method" for details on how to change the current value.

Table 5-29  Items Displayed on [Properties] Tab: [Eventflag(s)] Window

Change Item Contents

Name Displays the name of the eventflag.
This item is displayed only when the name is specified as an ID in the 
system configuration file.

ID Displays the ID of the eventflag.

Queue status Displays the wait queue status.
The following types of wait queue statuses are available.

Empty No tasks waiting

Waiting Tasks A task is waiting

O Pattern Displays the current bit pattern of the eventflag.

Initial pattern Displays the initial bit pattern of the eventflag.
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(b)  [n waiting task(s)] tab

The items listed in the following table will be displayed as information on tasks waiting for the target eventflag.
 "n" is the variable that indicates the total number of tasks queued to the target eventflag wait queue.

Figure 5-16  [n waiting task(s)] Tab: [Eventflag(s)] Window

Table 5-30  Items Displayed on [n waiting task(s)] Tab: [Eventflag(s)] Window

Attribute Displays the attribute of the eventflag.
There are following types of eventflag attributes.

[Queuing method]

TA_TFIFO Task wait queue is in FIFO order.

TA_TPRI Task wait queue is in task priority order.

[Queuing count]

TA_WSGL Only one task is allowed to be in the waiting 
state for the eventflag.

TA_WMUL Multiple tasks are allowed to be in the 
waiting state for the eventflag.

[bit pattern clear]

TA_CLR Bit pattern is cleared when a task is released 
from the waiting state for that eventflag.

Change Item Contents

Item Contents

Waiting task Displays the name of the waiting task.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

Task ID Displays the ID of the waiting task.

Priority Displays the priority of the waiting task.

Pattern Displays the wait bit pattern of the waiting task.
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Current value change method

The current value can be changed by inputting numeric values to the text box that is opened when the relevant item 
in this window is double clicked.

After changing the current value, the change will be reflected to the target system by clicking the  

button or by selecting [Refresh] in the [View] menu.

Option Displays the wait mode of the waiting task.
There are following types of wait options (request conditions) for eventflags.

TWF_ANDW AND waiting condition.

TWF_ORW OR waiting condition.

Item Contents
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[Data queue(s)] window

This window is opened by double-clicking an arbitrary data queue displayed in the [Data queue(s)] tab in the Main 
window, and displays detailed information on the selected data queue.

Figure 5-17  [Data queue(s)] Window

This section describes the following items:

-  Explanation of each area

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target data queue.
The current values of the displayed items cannot be changed in this window.

Table 5-31  [Items Displayed on [Properties] Tab: [Data queue(s)] Window

Item Contents

Name Displays the name of the data queue.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

ID Displays the ID of the data queue.

Queue status Displays the wait queue status.
There are following types of wait queue statuses.

Empty No tasks are waiting for transmission/reception.

Waiting 
Transmissions

A task is waiting for transmission.

Waiting Receptions A task is waiting for reception.

Total count Displays the capacity of the data queue area.

Using count Displays the number of data elements in the data queue.
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(b)  [n waiting task(s)] tab

The items listed in the following table will be displayed as information on tasks waiting for the target data queue.
"n" is the variable that indicates the total number of tasks queued to the target data queue wait queue.

Figure 5-18  [n waiting task(s)] Tab: [Data queue(s)] Window

Table 5-32  Items Displayed on [n waiting task(s)] Tab: [Data queue(s)] Window

Attribute Displays the attribute of the data queue.
There are following types of data queue attributes (methods for queuing tasks 
waiting for transmission).

TA_TFIFO Task wait queue is in FIFO order.

TA_TPRI Task wait queue is in task priority order.

Tasks waiting for reception are queued in the FIFO order.

Item Contents

Item Contents

Waiting task Displays the name of the waiting task.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

Task ID Displays the ID of the waiting task.

Priority Displays the priority of the waiting task.
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(c)  [n waiting data] tab

The items listed in the following table will be displayed as information on data waiting for the target data queue.
"n" is the variable that indicates the total amount of data queued to the target data queue wait queue.

Figure 5-19  [n waiting data] Tab: [Data queue(s)] Window

Table 5-33  Items Displayed on [n waiting data] Tab: [Data queue(s)] Window

Item Contents

Index Displays the data queuing index.

Data Displays the data contents.
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[Mailbox(s)] window

This window is opened by double-clicking an arbitrary mailbox displayed in the [Mailbox(s)] tab in the Main window, 
and displays detailed information on the selected mailbox.

Figure 5-20  [Mailbox(s)] Window

This section describes the following items:

-  Explanation of each area

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target mailbox.
The current values of the displayed items cannot be changed in this window.

Table 5-34  Items Displayed on [Properties] Tab: [Mailbox(s)] Window

Item Contents

Name Displays the name of the mailbox.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

ID Displays the ID of the mailbox.

Queue status Displays the wait queue status.
There are following types of wait queue statuses.

Empty No tasks/messages waiting.

Waiting Tasks A task is waiting.

Waiting Massages A message is waiting.
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(b)  [n waiting task(s)] tan

The items listed in the following table will be displayed as information on tasks waiting for the target mailbox.
"n" is the variable that indicates the total number of tasks queued to the target mailbox wait queue.

Figure 5-21  [n waiting task(s)] Tab: [Mailbox(s)] Window

Table 5-35  Items Displayed on [n waiting task(s)] Tab: [Mailbox(s)] Window

Attribute Displays the attribute of the mailbox.
There are following types of mailbox attributes.

[Task queuing method]

TA_TFIFO Task wait queue is in FIFO order.

TA_TPRI Task wait queue is in task priority order.

[Message queuing method]

TA_MFIFO Task wait queue is in FIFO order.

TA_MPRI Task wait queue is in message priority order.

Item Contents

Item Contents

Waiting task Displays the name of the waiting task.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

Task ID Displays the ID of the waiting task.

Priority Displays the priority of the waiting task.
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(c)  [n waiting message(s)] tab

The items listed in the following table will be displayed as information on messages waiting for the target 
mailbox.
"n" is the variable that indicates the total number of messages queued to the target mailbox wait queue.

Figure 5-22  [n waiting message(s)] Tab: [Mailbox(s)] Window

Table 5-36  Items Displayed on [n waiting message(s)] Tab: [Mailbox(s)] Window

Item Contents

Waiting message Displays the start address of the waiting message.

Priority Displays the priority of the waiting message.
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[Mutex(s)] window

This window is opened by double-clicking an arbitrary mutex displayed in the [Mutex(s)] tab in the Main window, and 
displays detailed information on the selected mutex.

Among the items displayed, the current value of Locking task can be changed in this window.

Figure 5-23  [Mutex(s)] Window

This section describes the following items:

-  Explanation of each area

-  Current value change method

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target mutex.
The current values of items marked with a circle in the Change column can be changed. See "Current value 
change method" for details on how to change the current value.

Table 5-37  Items Displayed on [Properties] Tab: [Mutex(s)] Window

Change Item Contents

Name Displays the name of the mutex.
This item is displayed only when the name is specified as an ID in the 
system configuration file.

ID Displays the ID of the mutex.

Queue status Displays the wait queue status.
There are following types of wait queue statuses.

Empty No tasks waiting

Waiting Tasks A task is waiting
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(b)  [n waiting task(s)] tab

The items listed in the following table will be displayed as information on tasks waiting for the target mutex.
"n" is the variable that indicates the total number of tasks queued to the target mutex wait queue.

Figure 5-24  [n waiting task(s)] Tab: [Mutex(s)] Window

Table 5-38  Items Displayed on [n waiting task(s)] Tab: [Mutex(s)] Window

Current value change method

The current value can be changed by selecting numeric values to the drop-down list that is opened when the 
relevant item in this window is double clicked.

After changing the current value, the change will be reflected to the target system by clicking the  

button or by selecting [Refresh] in the [View] menu.

O Locking task Displays the ID of the task locking the mutex.

Ceiling Always displays "-".

Attribute Displays the attribute of the mutex.
There are following types of mutex attributes (task queuing methods).

TA_TFIFO Task wait queue is in FIFO order.

TA_TPRI Task wait queue is in task priority order.

Change Item Contents

Item Contents

Waiting task Displays the name of the waiting task.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

Task ID Displays the ID of the waiting task.

Priority Displays the priority of the waiting task.
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[Timer queue] window

This window is opened by double-clicking an arbitrary timer queue displayed in the [Timer queue] tab in the Main 
window, and displays detailed information on the selected timer queue.

Figure 5-25  [Timer queue] Window

This section describes the following items:

-  Explanation of each area

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target timer queue.
The current values of the displayed items cannot be changed in this window.

Table 5-39  Items Displayed on [Properties] Tab: [Timer queue] Window

Item Contents

Object count Displays the total number of objects (tasks and cyclic handlers) queued to the 
timer queue.

Task count Displays the total number of tasks queued to the timer queue.

Handler count Displays the total number of cyclic handlers queued to the timer queue.
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(b)  [n waiting object(s)] tab

The items listed in the following table will be displayed as information on objects waiting for the target timer 
queue.
"n" is the variable that indicates the total number of objects queued to the target timer queue.

Figure 5-26  [n waiting object(s)] Tab: [Timer queue] Window

Table 5-40  Items Displayed on [n waiting object(s)] Tab: [Timer queue] Window

Item Contents

Waiting object Displays the name of the waiting object.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

Object ID Displays the ID of the waiting object.

Waiting clock Displays the remaining time until the task is released from the wait state with 
timeout or a cyclic handler is activated next (unit: msec).
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[Ready queue(s)] window

This window is opened by double-clicking an arbitrary priority displayed in the [Ready queue(s)] tab in the Main 
window, and displays detailed information on the ready queue corresponding to the selected priority.

The order of tasks queued to the relevant ready queue can be changed in this window.

Figure 5-27  [Ready queue(s)] Window

This section describes the following items:

-  Explanation of each area

-  Current value change method

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target ready queue.
The current values of items marked with a circle in the Change column can be changed. See "Current value 
change method" for details on how to change the current value.

Table 5-41  Items Displayed on [Properties] Tab: [Ready queue(s)] Window

Change Item Contents

O Priority Displays the priority of the tasks.

Task count Displays the total number of tasks queued to the ready queue.
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(b)  [n ready task(s)] tab

The items listed in the following table will be displayed as information on executable tasks in the target ready 
queue.
"n" is the variable that indicates the total number of tasks queued to the target ready queue.

Figure 5-28  [n ready task(s)] Tab: [Ready queue(s)] Window

Table 5-42  Items Displayed on [n ready task(s)] Tab: [Ready queue(s)] Window

Current value change method

The current value can be changed by inputting numeric values to the text box that is opened when the relevant item 
in this window is double clicked.

After changing the current value, the change will be reflected to the target system by clicking the  

button or by selecting [Refresh] in the [View] menu.

Item Contents

Ready task Displays the name of the ready task.

Task ID Displays the ID of the ready task.
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[Fixed-sized memory pool(s)] window

This window is opened by double-clicking an arbitrary fixed-sized memory pool displayed in the [Fixed-sized 
memory pool(s)] tab in the Main window, and displays detailed information on the selected fixed-sized memory pool.

Figure 5-29  [Fixed-sized memory pool(s)] Window

This section describes the following items:

-  Explanation of each area

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target fixed-sized 
memory pool.
The current values of the displayed items cannot be changed in this window.

Table 5-43  Items Displayed on [Properties] Tab: [Fixed-sized memory pool(s)] Window

Item Contents

Name Displays the name of the fixed-sized memory pool.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

ID Displays the ID of the fixed-sized memory pool.

Queue status Displays the wait queue status.
The following types of wait queue statuses are available.

Empty No tasks waiting

Waiting Tasks A task is waiting

Top address Displays the start address of the fixed-sized memory pool area.
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(b)  [n waiting task(s)] tab

The items listed in the following table will be displayed as information on tasks waiting for the target fixed-sized 
memory pool.
"n" is the variable that indicates the total number of tasks queued to the target fixed-sized memory pool wait 
queue.

Figure 5-30  [n waiting task(s)] Tab: [Fixed-sized memory pool(s)] Window

Table 5-44  Items Displayed on [n waiting task(s)] Tab: [Fixed-sized memory pool(s)] Window

Block size Displays the memory block size (in bytes) of the fixed-sized memory pool.

Free blocks Displays the number of free memory blocks.

Total blocks Displays the total number of memory blocks.

Attribute Displays the attribute of the fixed-sized memory pool.
There are following types of fixed-sized memory pool attributes (task queuing 
methods).

TA_TFIFO Task wait queue is in FIFO order.

TA_TPRI Task wait queue is in task priority order.

Item Contents

Item Contents

Waiting task Displays the name of the waiting task.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

Task ID Displays the ID of the waiting task.

Priority Displays the priority of the waiting task.
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[Variable-sized memory pool(s)] window

This window is opened by double-clicking an arbitrary variable-sized memory pool displayed in the [Variable-sized 
memory pool(s)] tab in the Main window, and displays detailed information on the selected variable-sized memory 
pool.

Figure 5-31  [Variable-sized memory pool(s)] Window

This section describes the following items:

-  Explanation of each area

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target variable-sized 
memory pool.
The current values of the displayed items cannot be changed in this window.

Table 5-45  Items Displayed on [Properties] Tab: [Variable-sized memory pool(s)] Window

Item Contents

Name Displays the name of the variable-sized memory pool.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

ID Displays the ID of the variable-sized memory pool.

Queue status Displays the wait queue status.
The following types of wait queue statuses are available.

Empty No tasks waiting

Waiting Tasks A task is waiting
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(b)  [n waiting task(s)] tab

The items listed in the following table will be displayed as information on tasks waiting for the target variable-
sized memory pool.
"n" is the variable that indicates the total number of tasks queued to the target variable-sized memory pool wait 
queue.

Figure 5-32  [n waiting task(s)] Tab: [Variable-sized memory pool(s)] Window

Table 5-46  Items Displayed on [n waiting task(s)] Tab: [Variable-sized memory pool(s)] Window

Top address Displays the start address of the variable-sized memory pool area.

Size Displays the size (in bytes) variable-sized memory pool area.

Free size Displays the total size (in bytes) of free memory blocks.

Acquirable max size Displays the maximum memory block size (in bytes) available.

Attribute Displays the attribute of the variable-sized memory pool.
There are following types of variable-sized memory pool attributes (task queuing 
methods).

TA_TFIFO Task wait queue is in FIFO order.

TA_TPRI Task wait queue is in task priority order.

Item Contents

Item Contents

Waiting task Displays the name of the waiting task.
This item is displayed only when the name is specified as an ID in the system 
configuration file.

Task ID Displays the ID of the waiting task.

Priority Displays the priority of the waiting task.

Size Displays the memory block size (in bytes) to be acquired.
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[Cyclic handler(s)] window

This window is opened by double-clicking an arbitrary cyclic handler displayed in the [Cyclic handler(s)] tab in the 

Main window, and displays detailed information on the selected cyclic handler.
Among the items displayed, the current value of Status can be changed in this window.

Figure 5-33  [Cyclic handler(s)] Window

This section describes the following items:

-  Explanation of each area

-  Current value change method

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target cyclic handler.
The current values of items marked with a circle in the Change column can be changed. See "Current value 
change method" for details on how to change the current value.

Table 5-47  Items Displayed on [Properties] Tab: [Cyclic handler(s)] Window

Change Item Contents

Name Displays the name of the cyclic handler.
This item is displayed only when the name is specified as an ID in the 
system configuration file.

ID Displays the ID of the cyclic handler.

O Status Displays the current state of the cyclic handler.
There are following types of cyclic handler statuses.

TCYC_STA Operational state

TCYC_STP Non-operational state
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Current value change method

The current value can be changed by selecting numeric values to the drop-down list that is opened when the 
relevant item in this window is double clicked.

After changing the current value, the change will be reflected to the target system by clicking the  

button or by selecting [Refresh] in the [View] menu.

Entry Displays the start address of the cyclic handler.
The display format varies as follows, depending on the load module 
generation condition.

-  With debug information:
File name # Line number (Symbol name)

-  With symbol information:
Address (Symbol name)

-  Without symbol information:
Address

Left time Displays the time (in msec) left before the next activation.

Interval Displays the activation cycle (in msec) of the cyclic handler.

Phase Displays the activation phase (in msec) of the cyclic handler.

Attribute Displays the attribute of the cyclic handler.
There are following types of cyclic handler attributes.

[Coding language]

TA_HLNG Start a processing unit through a C language 
interface.

TA_ASM Start a processing unit through an assembly 
language interface.

[Initial operation status]

TA_STA Operational state

[Whether to save activation phase]

TA_PHS Cyclic handler is activated preserving the 
activation phase.

Extra information Displays the extended information of the cyclic handler.

Change Item Contents
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[CPU exception handler(s)] window

This window is opened by double-clicking an arbitrary CPU exception handler displayed in the [CPU exception 
handler(s)] tab in the Main window, and displays detailed information on the selected CPU exception handler.

Figure 5-34  [CPU exception handler(s)] Window

This section describes the following items:

-  Explanation of each area

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target CPU exception 
handler.
The current values of the displayed items cannot be changed in this window.

Table 5-48  Items Displayed on [Properties] Tab: [CPU exception handler(s)] Window

Item Contents

Code Displays the exception code of the CPU exception handler.

Entry Displays the start address of the CPU exception handler.
The display format varies as follows, depending on the load module generation 
condition.

-  With debug information:
File name # Line number (Symbol name)

-  With symbol information:
Address (Symbol name)

-  Without symbol information:
Address
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[Interrupt handler(s)] window

This window is opened by double-clicking an arbitrary interrupt handler displayed in the [Interrupt handler(s)] tab in 
the Main window, and displays detailed information on the selected interrupt handler.

Figure 5-35  [Interrupt handler(s)] Window

This section describes the following items:

-  Explanation of each area

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target interrupt handler.
The current values of the displayed items cannot be changed in this window.

Table 5-49  Items Displayed on [Properties] Tab: [Interrupt handler(s)] Window

Item Contents

Code Displays the exception code of the interrupt handler.

Entry Displays the start address of the interrupt handler.
The display format varies as follows, depending on the load module generation 
condition.

-  With debug information:
File name # Line number (Symbol name)

-  With symbol information:
Address (Symbol name)

-  Without symbol information:
Address

Attribute Displays the attribute of the interrupt handler.
There are following types of interrupt handler attributes (interrupt handler coding 
language).

TA_HLNG Start a processing unit through a C language interface.

TA_ASM Start a processing unit through an assembly language 
interface.
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[Extended service call routine(s)] window

This window is opened by double-clicking an arbitrary extended service call routine displayed in the [Extended 
service call routine(s)] tab in the Main window, and displays detailed information on the selected extended service call 
routine.

Figure 5-36  [Extended service call routine(s)] Window

This section describes the following items:

-  Explanation of each area

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target extended service 
call routine.
The current values of the displayed items cannot be changed in this window.

Table 5-50  Items Displayed on [Properties] Tab: [Extended service call routine(s)] Window

Item Contents

Number Displays the function code of the extended service call routine.

Entry Displays the start address of the extended service call routine.
The display format varies as follows, depending on the load module generation 
condition.

-  With debug information:
File name # Line number (Symbol name)

-  With symbol information:
Address (Symbol name)

-  Without symbol information:
Address
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Attribute Displays the attribute of the extended service call rputine.
There are following types of extended service call routine attributes (extended 
service call routine coding language).

TA_HLNG Start a processing unit through a C language interface.

TA_ASM Start a processing unit through an assembly language 
interface.

Item Contents
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[Idle routine] window

This window is opened by double-clicking an arbitrary idle routine displayed in the [Idle routine(s)] tab in the Main 
window, and displays detailed information on the selected idle routine.

Figure 5-37  [Idle routine] Window

This section describes the following items:

-  Explanation of each area

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target idle routine.
The current values of the displayed items cannot be changed in this window.

Table 5-51  Items Displayed on [Properties] Tab: [Idle routine] Window

Item Contents

Entry Displays the start address of the idle routine.
The display format varies as follows, depending on the load module generation 
condition.

-  With debug information:
File name # Line number (Symbol name)

-  With symbol information:
Address (Symbol name)

-  Without symbol information:
Address

Attribute Displays the attribute of the idle routine.
There are following types of idle routine attributes (idle routine coding language).

TA_HLNG Start a processing unit through a C language interface.

TA_ASM Start a processing unit through an assembly language 
interface.
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[System] window

This window is opened by double-clicking an arbitrary object displayed in the [System] tab in the Main window, and 
displays detailed information on the selected object.

Among the items displayed, the current values of Dispatching disabled state and CPU locked state can be changed 
in this window.

Figure 5-38  [System] Window

This section describes the following items:

-  Explanation of each area

-  Current value change method

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target object.
The current values of items marked with a circle in the Change column can be changed. See "Current value 
change method" for details on how to change the current value.

Table 5-52  Items Displayed on [Properties] Tab: [System] Window

Change Item Contents

Version Displays the real-time OS name and version.

System clock Displays the system clock (unit: msec).

OS nest Displays the number of system processing nesting levels.

Interrupt nest Displays the number of interrupt service nesting levels.
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Current value change method

The current value can be changed by inputting/selecting numeric values to the text box/drop-down list that is opened 
when the relevant item in this window is double clicked.

After changing the current value, the change will be reflected to the target system by clicking the  

button or by selecting [Refresh] in the [View] menu.

O Dispatching disabled 
state

Displays the system status type (dispatching disabled state or 
dispatching enabled state).
There are following types of system statuses.

True Dispatching disabled state

False Dispatching enabled state

O CPU locked state Displays the system status type (CPU locked state or CPU unlocked 
state).
There are following types of system statuses.

True CPU locked state

False CPU unlocked state

Stack size Displays the system stack size (in bytes).
This item is displayed in the following format.
  Bottom address - Top address (size)

Stack rate Displays the percentage of the consumed system stack amount with the 
progress bar.

System SP Displays the stack pointer.

Change Item Contents
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[Max value] window

This window is opened by double-clicking an arbitrary maximum value information item displayed in the [Max value] 
tab in the Main window, and displays detailed information on the selected item.

Figure 5-39  [Max value] Window

This section describes the following items:

-  Explanation of each area

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target maximum value.
The current values of the displayed items cannot be changed in this window.

Table 5-53  Items Displayed on [Properties] Tab: [Max value] Window

Item Contents

Task Displays the maximum number of tasks that can be created.

Semaphore Displays the maximum number of semaphores that can be created.

Eventflag Displays the maximum number of eventflags that can be created.

Date queue Displays the maximum number of data queus that can be created.

Mailbox Displays the maximum number of mailboxes that can be created.

Mutex Displays the maximum number of mutexes that can be created.

Fixed memory pool Displays the maximum number of fixed-sized memory pools that can be created.

Variable memory pool Displays the maximum number of variable-sized memory pools that can be 
created.
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Cyclic handler Displays the maximum number of cyclic handlers that can be created.

Interrupt handler Displays the maximum number of interrupt handlers that can be registered.

Extended service call 
routine

Displays the maximum number of extended service call routines that can be 
registered.

Item Contents
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[Memory area(s)] window

This window is opened by double-clicking an arbitrary memory area displayed in the [Memory area(s)] tab in the 

Main window, and displays detailed information on the selected memory area.

Figure 5-40  [Memory area(s)] Window

This section describes the following items:

-  Explanation of each area

Explanation of each area

(a)  [Properties] tab

The items listed in the following table will be displayed as the detailed information of the target memory area.
The current values of the displayed items cannot be changed in this window.

Table 5-54  Items Displayed on [Properties] Tab: [Memory area(s)] Window

Item Contents

Name Displays the name of the section.

Top address Displays the start address of the section.

Size Displays the size (in bytes) of the section.



CHAPTER 5  WINDOW REFERENCE

User’s Manual  U16811EJ2V0UM 81

[Options] dialog box

This is the dialog box used to set the basic RD850V4 operation and display formats.
Settings made in this dialog box are saved by clicking the [OK] button, and will be reloaded when the RD850V4 is 

restarted.
This dialog box can be opened as following:

-  Select [Tool] menu -> [Option...] item on the Main window.

Figure 5-41  [Options] Dialog Box

This section describes the following items:

-  Explanation of each area

-  Function buttons

Setting item group selection area

Setting area
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Explanation of each area

(a)  Setting item group selection area

The items whose settings can be changed are grouped based on their types, and the setting items of the group 
clicked in this area will be displayed in the Setting area.
This area consists of the following groups.

Table5-55  Setting Item Groups

(b)  Setting area

Settings of the following items can be changed individually for groups selected in the setting item group selection 
area.

-  GENERAL

Figure 5-42  [Options] Dialog Box: GENERAL

[Show the tray icon.]
Sets whether to display the RD850V4 tray icon to the Windows status area (task tray).

[Show the property windows in the task bar.]
Sets whether to minimize the Properties window currently open, as a button on the Windows taskbar.

Group Name Description

GENERAL Change the general settings to the RD850V4.

Start Up Change the settings related to the operation when the RD850V4 is started.

BASE Change the general settings to the windows.

COLOR Change the display color and background color of components arranged in the 
window.

TAB Change the settings related to the display of tab control.

TREE Change the settings related to tree display control.

LIST Change the settings related to list display control.

ON Displays the RD850V4 tray icon in the Windows status area (default).

OFF Does not display the RD850V4 tray icon in the Windows status area.

ON Minimize the Properties window currently open, as a button on the Windows 
taskbar (default).

OFF Does not minimize the Properties window currently open, as a button on the 
Windows taskbar.
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[Reset all setting values.]
Restores the default value of all the set values by clicking the [Reset] button.

-  Start Up

Figure 5-43  [Options] Dialog Box: Start Up

[Restore a window position.]
Sets whether to restore the Main window position when the RD850V4 is started next time.

[Restore a window size.]
Sets whether to restore the Main window size when the RD850V4 is started next time.

[Save the current window position and size.]
The position and size of the Main window are saved by clicking the [Save] button.
If the [Restore a window position.] or [Restore a window size.] check box is selected, the Main window will be 
opened at the position when it was saved or with the same size, when the RD850V4 is restarted the next 
time.

[Expand all nodes in TreeView.]
Sets whether to expand the resource structure in the tree view area in the Main window when the RD850V4 
is started.

ON Opens the Main window at the position where it was saved.

OFF Opens the Main window at the default position (default).

ON Opens the Main window with the size when it was saved.

OFF Opens the Main window with the default size (default).

ON Displays the expanded resource structure of each node when the RD850V4 is 
started.

OFF Displays the collapsed resource structure of each node when the RD850V4 is 
started (default).
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-  BASE

Figure 5-44  [Options] Dialog Box: BASE

[Show the tool bar.]
Sets whether to display the toolbar in each window.

[Show the status bar.]
Sets whether to display the status bar in each window.

[Display numerical values using hexadecimal notation.]
Selects the radix notation for numeric values.

[Change the status on updating mode, "manually".]
Selects the window update mode in each window.
For Properties window, this setting will be valid when it is newly opened.

[Change the status on closing a window, "manually".]
Selects the window discard mode when newly opening a property window.

ON Displays the toolbar in each window (default).

OFF Does not display the toolbar in each window.

ON Displays the status bar in each window (default).

OFF Does not display the status bar in each window.

ON Hexadecimal

OFF Decimal (default)

ON Sets the manual update mode to each window.

OFF Sets the automatic update to each window (default).

ON Sets the manual discard mode.

OFF Sets the automatic discard mode (default).
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-  COLOR

Figure 5-45  [Options] Dialog Box: COLOR

[Change a foreground color.]
Sets the character display color.
An arbitrary color (default: black) can be specified in the color dialog box that is opened, by clicking the 
[Change...] button.

[Change an updating color.]
Sets the color of items whose object status has been updated.
An arbitrary color (default: red) can be specified in the color dialog box that is opened, by clicking the 
[Change...] button.

[Change a changing color.]
Sets the color of items whose object status has been changed.
An arbitrary color (default: blue) can be specified in the color dialog box that is opened, by clicking the 
[Change...] button.

[Change a background color.]
Sets the background color for components.
An arbitrary color (default: white) can be specified in the color dialog box that is opened, by clicking the 
[Change...] button.

-  TAB

Figure 5-46  [Options] Dialog Box: TAB

[Locate the tabs across the bottom of the control.]
Sets the position where tabs are placed in a window.

ON Displays tabs at the bottom of a window.

OFF Displays tabs at the top of a window (default).
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[Display only one row of tabs.]
Sets whether to display tables in one line (scroll mode).

[Change in appearance of the tabs, when the mouse passes over them.]
Sets whether to change the tab appearance when the tab is pointed to by the pointer.

-  TREE

Figure 5-47  [Options] Dialog Box: TREE

[Draw lines between tree nodes.]
Sets whether to display dotted lines that connect each node in the Tree view frame.

[Display plus-sign and minus-sign buttons next to tree nodes that contain child tree nodes.]
Sets whether to display the plus/minus sign indicating expanded/collapsed structure in the Tree view frame.

[Change in appearance of the tree nodes, when the mouse passes over them.]
Sets whether to change the node label appearance when the label in the Tree view frame is pointed to by the 
pointer.

ON Displays tabs in the scroll mode (default).

OFF Displays tabs dividing into multiple lines in the display area.

ON Uses the hot track function for tabs (default).

OFF Does not use the hot track function for tabs.

ON Displays dotted lines that connect each node (default).

OFF Does not display dotted lines that connect each node.

ON Displays the plus/minus sign in the Tree view frame (default).

OFF Does not display the plus/minus sign in the Tree view frame.

ON Uses the hot track function for the node label in the Tree view frame (default).

OFF Does not use the hot track function for the node label in the Tree view frame.
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-  LIST

Figure 5-48  [Options] Dialog Box: LIST

[Change the way in which items are displayed.]
Sets the display format in the list view area in the Main window.

[Show a property window by one click.]
Sets the opening method of Properties window screens.

[Draw grid lines around items and subitems.]
Sets whether to display the grid lines between the displayed statuses (line/row).

[Change in appearance of the objects, when the mouse passes over them.]
Sets whether to change the label appearance when the label of a displayed status is pointed to by the 
pointer.

Function buttons

Large Icons Displays the objects with large icons.

Small Icons Displays the objects with small icons.

List Displays the objects in the list format.

Details Displays the object list with detailed information (default).

ON When an object is clicked, the corresponding property window opens.

OFF When an object is double-clicked, the corresponding property window opens 
(default).

ON Displays the grid lines between the displayed statuses.

OFF Does not display the grid lines between the displayed statuses (default).

ON Uses the hot track function for the label of the displayed status.

OFF Does not use the hot track function for the label of the displayed status (default).

Button Function

OK Determines the settings and closes this dialog box.

Cancel Closes this dialog box without saving the settings.

Help Displays the help window for this dialog box.
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[About RD850V4] dialog box

This dialog box is used to display the version information of the RD850V4.
This dialog box can be opened as following:

-  Select [Help] menu -> [About RD850V4...] item on the Main window.

Figure 5-49  [About RD850V4] Dialog Box

This section describes the following items:

-  Explanation of each area

-  Function buttons

Explanation of each area

(a)  Version information display

This area is used to display "the product name, version number of the RD850V4, [date of product build] and 
copyright year".

Function buttons

Version information display

Button Function

OK Closes this dialog box.
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CHAPTER 6  ERROR MESSAGES

6. 1  Error Message Format
Messages output by the RD850V4 are displayed in the message area in the status bar in the Main window, or in the 

message dialog box shown in Figure 6-1.
In the RD850V4, messages are classified into four types, each of which can be identified by the icon displayed at the 

top of the message and alphabetic character at the top of the error code.

Figure 6-1  Message Dialog Box Example

Table 6-1  Message Types

Icon Prefix Type

I
Information
This message is displayed to report some kind of information.

Q
Question
This message is displayed when some kind of choice is required for the opera-
tion.

W
Warning
This message is displayed to report some kind of information.

E
Operation error
This message is displayed when an operating error occurred and execution is 
not possible.
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6. 2  Information Message Lists
The contents displayed as information messages are as follows.
"%s" in each message means a character string that varies depending on the RD850V4 processing.
Information message is the item displayed only in the message area in the status bar in the Main window.

[Caution]  This message is displayed when an object is selected in the Main window and the corresponding 
Properties window is opened.

I0001: The object "%s" is selected.
This message is displayed when the window discard mode is changed in the Properties window.

I0102: Object information is updated <automatically / manually>.
This message is displayed when the radix notation is changed in the Main window or a Properties window.

I0103: A numerical value is displayed using <decimal / hexadecimal> notation.
This message is displayed when the radix notation is changed in the Main window or a Properties window.

I0201: RD850V4 has connected to the debugger.
This message is displayed when the RD850V4 is successfully connected with the debugger.

I0202: RD850V4 has disconnected from the debugger.
This message is displayed when the RD850V4 and the debugger are disconnected.

6. 3  Question Message Lists
The contents displayed as inquiry messages are as follows.
When this message is displayed, selection of the [Yes] or [No] button may be required.

Q0001: Do you wish to disconnect from the debugger?
This message is displayed when [Disconnect] in the [Tool] menu of the Main window is selected.

Q0101: The information currently displayed may be out of date. Do you wish to update it?
This message is displayed when an object status is changed in the Properties window during manual update 
mode.

6. 4  Warning Message Lists
The contents displayed as warning messages are as follows.
"%s" in each message means a character string that varies depending on the RD850V4 processing.

W0001: The debugger is running.
This message is displayed when an attempt is made to update resource information or to change an object 
status while the debugger is running.
Resource information can be updated or object statuses can be changed only when the debugger operation has 
been stopped.

W0002: RX850V4 is not initialized.
This message is displayed when an attempt is made to update resource information or to change an object 
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status before RX850V4 initialization is completed.
Resource information can be updated or object statuses can be changed only after RX850V4 initialization is 
completed.

W0003: The object "%s" does not exist.
This message is displayed when an attempt is made to acquire resource information or to change an object 
status but the target object could not be found.

W0101: RD850V4 cannot be changed, because CPU status is locked.
This message is displayed when an attempt is made to change an object status during the "CPU locked state".
Object statuses can be changed only during the "CPU unlocked state".

W0102: RD850V4 cannot be changed, because the "%s" system call was not found.
This message is displayed when a service call required for changing an object status is not linked with the load 
module.
Object statuses can only be changed by using the load module to which a service call required for status change 
processing is linked.

W0103: The input value is empty or an illegal numerical value.
This message is displayed when invalid values were specified for object items whose status can be changed.

6. 5  Operation Error Message Lists
The numbers and contents displayed as error messages and their meanings are as follows.

E0001: RD850V4 could not connect to the debugger.
This message is displayed when connecting with the debugger failed.
The RD850V4 and debugger must be connected while the debugger is running.

E0002: RX850V4 is not loaded.
This message is displayed when the RX850V4 failed to acquire information.
The assumed cause is that the RX850V4 is not linked with the load module.

E0101: The state of your selected object is illegal.
This message is displayed when the RD850V4 failed to analyze acquired information.
The assumed cause is that the data structure of the target object is invalid.

E0102: The queue information may be corrupted.
This message is displayed when searching for the queue contents failed.
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